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Using the CBL2 and Light Probe to Collect Data

1. Plug the light sensor into a Channel port of your CBL2. }]*E!_[!}]._[!]E
Run a data collection program, such as the DataMate onlcs
App. Press [APPS), then use [=] to scroll down to :Ct1aHelF
DataMate. : Dansk

HD=at aMat.e
: Deutsch

The DataMate program will automatically recognize the *EzFrarol

light sensor. The number in the top right corner is the JFrancais
reading of light intensity in milliwatts per square
centimeter.
2. If DataMate does not automatically recognize the light CH 1: LIGHT 0.0089

sensor, then select option 1: SETUP by pressing [1].

MODE: TIHE GEAFH-20

1:ZETUF Y:ANALYZE
cETRHRT L:TOOL=
Z:GkAFH a:gUIT

3. Select the Channel port into which you plugged the FCH 1:
light sensor. Press (] or [+] so that the arrow is next to CHz:
the appropriate Channel. Press [ENTER. ng :

HODE: TIHE GEAFH-20

1:0K =:ZERD
ZCALIERATE 4:XAYE/LOAD

4. Look for the LIGHT sensor. If you do not see it on the SELECT 2EN:0FK
current screen, select 7 MORE by pressing (7). When ?;ﬁHPEHHTUHE
y.ou see LIGHT listed, select 5: LIGHT by pressing S CONDUCTIVITY
5). W:FRESSURE
E:FORCE
B:HEART RATE
7 :MORE
B:RETURN TO *ETUF =CKEEN
SELECT “En=0OFR

1:ACCELEROMETER
c:COLORINETER

ZCOZORE:

4:NICROFHONE

E:LIGHT

B:0. DRV GENCHGALY

r*MORE

B:RETURN TO ZETUF ZCRKEEN
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5. Select the light probe that you are using by pressing (1], LIGHT
(2], or (3. You will be returned to the main screen. 1:LIGHT SOOCLY

SLIGHT gL
FLIGHT 1E000aCL D

6. Read the light intensity (in milliwatts per square - < >
centimeter) by observing the number in the top-right Rl ( 0-0089

corner of the screen.

MODE: TIHE GEAFH-20

1:ZETUF Y:ANALYZE
ZETHRT L:TOOL:
Z:GkAFH a:gUIT

7. To collect the next data point, move the light probe
away from the light source, then read the intensity.
Continue until you have collected the necessary data.

8. Press (6] to return to the home screen.
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Generating a Scatterplot Using a Graphing Calculator 84]

1. Enter data into the lists. 1] Lz L= 1

.b

)

B .

g =188
i .

1.

1.

i .
[ ArEL

2. Turn on the [STAT PLOT] by pressing [2nd)[Y9). Select the DH}{"‘E Flokz
necessary options. In this case, choose a scatterplot with .
; > R gFe! B | Jd
independent variable in [L1] and dependent variable in HH-- HIH |~
L. ®listiL4
Y1listiL:z0
Mark: B -
3. Choose an appropriate window by pressing I T MO0
and specifying the appropriate domain and range. Use Fml r'EEll
(«)(~] to move up and down the list. Type the desired EEET;E 1 =
value then press [ENTER]. b ] r'|=l.El
Ymax=1
Y=cl=.1
Ares=1

4. To view the graph, select [GRAPH].
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Generating a Scatterplot Using Microsoft Excel

1. Enter your data into a blank Excel spreadsheet.

Microsoft Excel - Book1

Igl_1 Eile Edit %iew Insert Format Tools Data Window Help  Adobe PDF
N EE RGBT RSB F 8 T B e
e Il s B R N | 2, Ay 3| o Reply with Changes... End Review . [l 150 51 =6 M
E21 - A
A | B | C | D [ E | F | & | H [ 1
1
2
Distance | Intensity
3 (2) )
ER () (mWfl:mz}
L5 0.6 0.7454
B 0.7 0.5657
s 0.8 0.4588
8 0.8 0.313%
9| 1 0.2538
10 P! 0.214%
11 12 0.1751
| 12| 13 0.147%
13 1.4 0.1333
14 1.5 0.1236
15 1.6 0.11
15| 17 0.0973
17 1.8 0.0306
18 19 0.0808
19| 2 0.075
winl

2. Choose Chart from the Insert menu.

Microsoft Excel - Book1

@_] Fle Edit Wiew | Insert | Format  Tools Data  Window  Help
HAN=A" N-EE ] cells.. B
gy fe o o) Gy Rous F+ Feply with Change
N2E - Calumns
A | E Worksheet E | F
1_ ||ﬂ Chart... M
2 ﬁymlzncnl...v\x
3 Pane Break
% S Function...
E Mame 3
7 4 Comment
a e
T Picture: b
10 23| Diagram...
11| Object...
|12 : .
13 g, Hyperlink.,.  Chrl+K
14
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Chart Wizard - Step 1 of 4 - Chart Type

Skandard Types | Cuskomn Tvpes

Chart bype:

[l =efumn =
E Bar

|ﬁ Line
2 Fie

Chart sub-type:

B (Scatter)
‘ Area

i@ Doughnut
s Radar

>
@ Surface e M

@ Bubble

o
5o Stock | W

Scatter, Compares pairs of values,

Press and Hold ko Yiew Sample |

Cancel | | Mesxt = | Einish |

Algebra 2

I’ve Seen the Light!
3. Select XY (Scatter) from the Chart Type selection box then click Next.

4. To select the Data Range, click the Collapse Dialog button next to the Data Range text box.

Chart Wizard - Step 2 of 4 - Chart Source Data EIE'

[rata Range Series

Tao create a chart, click in the Data range box, Then, on the

worksheet, select the cells that contain the data and labels you
want in the chart.

Draka range: @
Series in; ) Rows

) Columns

Cancel ][ < Back ” Mext = l[ Firish
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5. Select the cells containing your data then click the Collapse Dialog button next to the
floating Chart Source Data box. You will return to the Chart Wizard dialog box.

Distance Intensity
() ()

(1) (W l:m:)
0.6 0.7454
07 0.5657
0.8 0.4538
0.9 0.3199
1 0.2538 |
1.1 02143
1.2 0.1751
1.3 0.1479
14 0.1333 |
15 01236
16 011
17 0.0973
1.3 0.0906 |
1.9 0.0208 !
______ 2. oo

Chart Wizard - Step 2 of 4 - Chart Source Data - Datar... @E|

=Sheet11$CH5$0$19

6. Click the Series tab to edit the source data features.

Source Data

Data Range

0.5

LAy

06

%]

0.4

0.3

0z

ol

L]

o

Drata range:

Series in:

PX
Series R
*
*
-
L]
* &
ey L E—
05 1 15 2 25
=sheet1!$C$5: 0419

O Rows
(&) Colurmns

Cancel ] [ < Back ” Mext = ] ’ Einish
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7. Give “Series 1” an appropriate name. Click inside the Name text box and type an appropriate
name. In this example, we will use “Leg Length.” Click Next.

Chart Wizard - Step 2 of 4 - Chart Source Data @E|

[raka Range Series

Light Intensity
05
*
of
06 +
[ =
0.4 # Light Intanit
0.5 =
0.z —
* 4 &

04 A

]

o 05 1 15 z 25
Series

Light Intensity
2 Walues: ' "
yyalues: | =Shestl$D45: 40419

Cancel ][ < Back ” et >kj’ Einish
\

8. At this point you can customize the chart options, including the Chart title, Value (x) axis,
and Value (y) axis labels. Enter the pertinent Chart Options, including appropriate labels
for the x-axis and y-axis. You can also customize the axes, gridlines, legend, and data labels
by clicking on the appropriate tab at the top of the dialog box. Click Next when you are
ready to continue.

Chart Wizard - Step 3 of 4 - Chart Options

L. o Awes Gridines | Legend | Data Labels
Chart title:
Light Intensity Light Intenzity
Walue () axis: A .
- - 0T
Distance {ri) ‘E - .
Yalue () axis: :Il. 05 -
; =04
Inkensity {m fcmz) %. g .
$ 0z +
i Teel, o
i
u us 1 18 z 25
Distance [m]
Cancel ] [ < Back ” Mext = ] [ Einish
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9. Select the location of the new chart, then click Finish.

Chart Wizard - Step 4 of 4 - Chart Location

Place chart:

|_|_l_ " hsnewshest;  |Chartl

¥ As gbject in: Sheeti R
@ Cancel | « Back | | Firish |

Microsoft Excel - Book1

IE_’I File Edit Wew Insert Format  Tools Data Window Help  Adobe POF
AR NN NERE NS WA WP WECR:-SAS A RACRAE- N0 R TN LN~ HELC -0 | B I U|ES
NI Mot i WA W e WA | | (& By @ | ¥4 Reply with Changes... End Review. ! iyt 5| !
128 - e
A | e [ ¢ [ b | E | F | & | H [ ¢ [ 4 [ kK [E T M [ N
1
=
Distance Intensity
Ll D) ()
4 | (o) (mchm:)
5 0.6 0.7454 Light Intensity
B 07 0.5657
| 0.8 04582 08
g 0.9 0.3199 *
B 1 0.2538 o
10 i 0.2149 06
73] 12 0.1751 g *
12 13 0.1479 S .
13l 1.4 0.1333 E 4
14 15 0.1236 £
15| 16 011 503 K
16| 17 0.0973 2 Te
] 18 0.0906 |
18 19 0.0808 0.1 e
19 2 0.075
— ]
e ] as 1 15 2 25
| 22 | | Distance (m)
23
24
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Generating a Scatterplot Using TI-Interactive

1. Open a new Tl-Interactive document.

%
File Edit Yiew Insert Format Tools Help
ODeB/dQ v L h@y
F | sz -l B 7 U

2. Select the list icon from the scroll bar to activate the DATA EDITOR.

3. Create a scatterplot. Select the scatterplot icon " from the DATA EDITOR toolbar and
from the drop down menu.

a Help

[-] - 58 [ | 8|
= =

== P |
& e
L

—pkl |

4. Click onthe STAT PLOTS tab then enter the list names that contain the data, independent
variable first and dependent variable second.

u”\%

'?"‘l—l':m]m]

o | Wil

b ——
e

im| Stat Plots

I7| L1 =

L2
.
Independent Wariable; I
gl D:np_l,l.l’-‘«lll Cloge | Help | y
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5. Set an appropriate window and label the axes by clicking the FORMAT button. In the
Window tab, enter the appropriate domain and range for the function.

Ticeon i
File Edit Wiew Tools Zoom Calculate Draw  Help
a8 BE AU AL/ ke 2
NS DA M N MO 22|
1EI:
8
o1
B
2
W 1IDII8I_IEI:1II2I_I2II‘II1IEII8II1ID r
2t
_45
i
_3:
1ol

Window |Animate| dwes | Grid | Trace | Labels|

Hmir: I—'ID—

IV Automatic ¥Step Srna: |1D—

Hatem IW Facale: I1—
“fmir: I"‘U—

T Im—

rroale: |1—

Cancel | Apply | Help |

6. After entering the Xmin, Xmax, Xscale, Ymin, Ymax, and Yscale, click the APPLY button.

Format

[v Automatic #Step

windov l.&nimate] dwes | Grid | Trace | Labels |

Ak IEI—
Hmas: |3—
l— Hzcale: |1—
“mir: IU—

' mas: I"—

“zcale: |1—

3

Cancel |

Help |

ok |

Apply m
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7. The scatterplot should be displayed with the specified domain and range.

003 *
c »
~nz2 '
“.
[t
. 1
03 06 09 1.2 15 18 21 24
Distance (m)

i x
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Determining a Function Rule Using a Graphing Calculator

1. The graph appears to be an inverse variation function,

y= 5 so multiply xy to find k, the constant of
X

variation.

Go to the List Editor by pressing [STATJ[ENTER]. Use
(+](«] to select the List 3 header. Enter the formula [L3] =

[L1] [L2] by pressing [2nd)[1](x])2nd][2]. Press [ENTER].

. Find the average value of List 3 by returning to the

home screen and using List operations. Press [2nd][Y=].
Press [2nd)[STAT] ] ](3]. Enter [L3] by pressing [2nd](3],
then press [ENTER].

. Substitute this value of k into the parent function and
verify using a graph.

Press [Y5) then enter the function. Press to view
the graph.

TMT? Technology Tutorials Algebra 2
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L1 Lz L= 3
B FYEY | oo
7 .ERE7
‘B 4CEA
.8 .x189
1 ZEZA
1.1 .ziig
1.7 A7el

Lz =L1*LzH

mearntlz

. 2SEES2EEETY

AME] Flotz Flot:
~Wi1B. 235850
i
M=
~Ny=
~Ne=
~NeE=
~No=
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4. This function is not a good fit. Try inverse-square

variation, y :Lz. Multiply x°y in order to find an
X

approximate value for k, the constant of variation.

Go to the List Editor by pressing [STAT][ENTER]. Use
(+](«] to select the List 4 header. Enter the formula [L4] =

[L1]? [L2] by pressing 2nd|T]=2)x](2nd][2]. Press [ENTER].

Find the average value of List 4 by returning to the
home screen and using List operations. Press [2nd][Y=).
Press [2nd]([STAT]>]D](3]. Enter [L4] by pressing [2nd](4],
then press [ENTER].

. Substitute this value of k into the parent function and
verify using a graph.

Press [Y=], then enter the function. Press to view
the graph.
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Lz Lz U] y
T KT
-t B T [T
HEER | JZEFON
xi90 | (z@79d
ZEx@ | .25:A
zihn | (Z3:RzH
A7El | zindz

Ly =12+ zN

meanilz

. 232ASPEEET
meanily 2
. . 275G EE

AE Flokz Flok:
~WiB. 27 3-HER
wHe=
wHe=
wNy=
wHe=
“NE=
wMNe=

l
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Using the Graph to Make Predictions

1. Press to enlarge the window. Adjust the
settings to make the window large enough to predict
with.

2. Press [GRAPH] then [TRACE]. Press [4] to select the
function then trace to the prediction using the right and
left arrow keys, [(«]].

Using the Table to Make Predictions

1. Press (WINDOW]. Enter values for ThiStart and ATb1, the
value of the x increment.

2. Press [GRAPH]. Use the up and down arrow keys, [4]
and [+], to scroll to the desired value.

TMT? Technology Tutorials Algebra 2
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W IHDOL
wmln=g
AMAaK=5
Aecl=.25
Ymin=A
Ymax=1
Yecl=.1

“res=1

g DR o

U= PE e NS OENAT 5

THELE SETUF
ThlSstart=A
alhl=1
Indent.:
DeFrand:

# Y9 Ve

.7H MR
.74 qzuz |y
8 HZEEE | 4

Higl | u
Iﬂh: qognl | oy
i: I .x8az8 | 4
-84 :BRE | n

m=a 82
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Determining a Function Rule Using Microsoft Excel

1. Click to select your chart. Choose Add Trendline from the Chart menu.

Microsoft Excel - Book1

@J File Edt ‘iew Insert Format Tools | Chart | Window Help  Adobe FDF
RN RERE I R4 e et 2 x4l e §ime 210 Z|B I U|==3
Chart Ares B A Chart Options...
A | B | & | Lacation. .. F | 6 | H | | | J | K | L | M | N
% Add Data. ..
il Thetancs i Add Trendline. .. h |
L) ) 3-D Wiew..
4| (m) (1 W/ cm:) w
5] 0.6 0.74354 Light Intensity
6 0.7 0.5657
L 0.8 0.4588 08
8 0.9 03195 *
— 07
L5k 1 0.2538
10 1.1 0.214% 06
11 12 0.1751 = *
12| 13 01475 g% .
13 14 01333 W <04 o
14 L5 0.1236 £
— ] *
15| 16 0.11 g 03
16 | 147 0.0973 oz +
17 1.8 0.0506 e ”
18 19 0.0308 01 e
19 2 0.075
Eil o
TR 0 0.5 1 15 2 2.5
Z Distance (m)
23 »
24
o]

2. The Add Trendline dialog box will appear. Click on the parent function for the trendline
you wish to graph. If you select Polynomial or Moving Average, be sure to select the order
or period, respectively.

Add Trendline X

Tvpe Options
Trend/Regression type

R,

Linear Logarithriic Palynomial
Power Exponential Moving Average

Based on series:

Light Intensity

I Ok ] [ Cancel
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3. Click on the Options tab. Click on the Display equation on chart check box. Set any other
features that you would like to customize related to your trend line. Click OK.

Add Trendline %]

Tvpe Optians
Trendline name
(®) Aukomatic:  Power (Light Inkensity)

) Custom:

Forecast

Farward: ] % | Units
Backward: a % | Units

lay R-squared walue on chart

[ [0 4 l [ Cancel ]

4. Customize the appearance of the equation by double-clicking on the equation. The Format
Data Labels dialog box will appear. You can change the appearance of the equation,
including font, number, and alignment. Click OK when you are finished.

Chart Title
0.8
v ﬁ\
06
3 i
505
: X
<04
2 \
2 S
3 0.3 n
z ™
02 =
\g\"‘"‘ﬂ
0.1 L
y = EEJE'J:‘E?MX'T
a 1
1 ns 1 15 2 25
Distance (m)
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Format Data Labels

Patterns |i Murber | Alignment
Fant: Fant skyle: Size:
Arial Bald 12
T Alba Matker ~ Reqular 9 "~
T Alba Super Ttalic 10
Algerian 11
S — | o o -
Undetline: Color: Background:
Mone W Automatic | | Automatic hd
Effects Preview
[ Strikethrough
AaBbCcYyZz __|
auto scale

This is a TrueTvpe font, The same Font will be used on both vour printer and

Yaur sCreen.,

Algebra 2
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&

I ol Q’J ’ Cancel

Using the Graph to Make Predictions

1. Double-click the trendline on your chart. The Format Trendline dialog box will appear.

Intensity (mW/cm2)

0.4

07

0.6

04

0.4

0.3

0.2

01

Chart Title
X
\
%

N

h} y = 0[2695x %7
I"Lig t?ntensity" Trendline 1 |

0 0.5 1 1.5 2 25

Distance (m)
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2. Click the Options tab. In the Forecast text boxes, enter the number of units that you would
like to extend the graph either Forward or Backward beyond your data set. Click OK.

Format Trendline @

Patterns

Forecask
Forward:

Backward

Tvpe Options

Trendline name
(%) wkomatic:  Power Light Intensity)

O Custony

RS

0

Display equation on chark

[ bisplay R-squared value on chart

I

OKM [ Cancel

3. Use the extended graph to estimate the necessary x- or y-value.

0.8

Chart Title

07

0.6

0.4

0.4

—'-‘-—-¢
L
||

0.3

Intensity (mW/ cm2)

0.2

r

4937

01

™

V¥ U.2695X

Mt_""‘-n—.—._

1 15 2

Distance (m)

2.4 5|

34
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Determining a Function Rule Using TI-Interactive @

1. The graph appears to be an inverse variation function, y = K so multiply xy to find k, the
X

constant of variation then find the average value. In the Data Editor, click the Formula tab
under the List 3 header.

r

i22 Data Editor

File Edit View Insert Format List Data Help
=== El 1
W ¥ oGO o EaEE!
[T Math ~n < B 7 U
listname L1 L2 L3 L4
formula {} {.} {..} {.}

1 0.8 0.7454

2 0.7 D0.5657

3 0.8/ 0.4588

4 0.9 0.31588

5 1 0.2538

6 1.1 0.2148

7 1.2 0.1751

8 1.3 0.1479

9 1.4 0.1333

10 1.5 0.12386

11 1.6 0.1

12 1.7 0.0973

13 1.8 0.09086

14 1.3 0.0808

15 2 0.075

16

i= Data Editor,

'3 Information E| Fle Edit View Insert Format List Data Help
E] 1
Hame: By oo EHREEIE
||-3 [TI Math ~e A A U =
Palette -
Farmula: .‘isumn;: {L1} {LZ} {L3} {L% 1=
Cancel 'O T |-
||“1 #L2 4 1 0.6 0.7454 0.44724
w 2 0.7 0.5657 0.39599
3 0.8 0.4588 0.36704
4 0.9 0.3199 0.28791
5 1 0.2538 0.2538
6 1.1 0.2149 0.23839
7 1.2 0.1751 0.21012
8 1.3 0.1479 0.19227
9 1.4 0.1333 0.186862
10 1.5 0.1236 0.1854
11 1.8 0.11 0.178
12 1.7 0.0973 0.16541
13 1.8 0.0906 0.16308
14 1.9/ 0.0808 0.15352
15 2 0.075 0.15
16 1
17
18
19 -
o | I
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3. From the List menu, choose Calculate, then choose Calculate Mean.

i=2 Data Editor E‘@|E|
File Edit WYiew Insert Format | List Data Help
Insert Mew List. ..
% x Lﬁ @ "j Edit List Formula, .. E
|TI Wath ﬂ,T Sork List =
Operations LN
listname L1 L2 Calculate 3 Find Minimum
formuita {} {} {7 {F Find Mazimum
1 0.6 0.7454 0.44734 W
2 0.7 0.5657|0.39599 Calculate Median
3 0.8 0.4588 0.36704 Calculate Sum
4 0.9 0.3199 0.28791 Caleulate Product
5 1 [0.25838 0.2538 Calculate Standard Deviation
[ 1.1 0.2149 0.23539 Calculate Variance
7 1.2 0.1751 0.21012
8 1.3 0.14789 0.,18227
H 1.4 0.1333 0.18662
10 1.5 0.1236 0.1854
11 1.6 0.11 0.176
12 1.7 0.0973 0.16541
13 1.8 0.0806 0.18308
14 1.9 0.0808 0.15352
15 2 0.075 0.15
16 1
17
18
19 -
o e
Return the mean value of a list

4. From the Input List drop-list box, choose L3. Click Calculate.

Calculate Mean §|

Input List: {L3] - Calculate
Frequency List: | [Mone] - Copy
Mean: | 238063
Help
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5. Substitute this value of k into the parent function and verify using a graph. From your
Scatterplot, click the Functions button.

File Edit Wiew Tools Zoom Calculate Draw  Help

RV AMY ER MR EY
CHam)  Fomm

Inside the Functions dialog box, click the f(x) tab, then enter your function in the top text
box. Click Close when complete.

4
1
< !E m n.a
=] tat F'Iots] 08
) |— . | § 0.6
~— N € K
e »
~ | o \
£ L J
Independent ' ariable: ’Xi £03
Deselect.-’-‘«ll| Cop_l,l.t‘-‘nll| Close | Help | 312 *5;.-‘.‘-‘--
. [Ttee

03 08 09 12 15 18 21 24
Distance {m)

6. This function is not a good fit. Try inverse-square variation, y = Lz Multiply x*y in order
X

to find an approximate value for k, the constant of variation. In the Data Editor, clear L3

then repeat Steps 1 through 5. Set L3 = (L1)? x L2 by following steps 1 and 2. Find the
average value of L3 by following Step 3.
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i=5 Data Editor = ||B][*] i== Data Editor E| E|§|
File Edit “iew Insert Format List Data Help File Edit View Insert Format | List Data Help
2 1 Insert Mew List..
x Lﬁ @ 2 % % 3E 75 x Lﬁ @ 2 Edit List Formula... E
=] Sork List =
[T Math ~w B 2 U = [rman [0 Orerations  E
listname L1 L2 L3 L4 - fistname L1 id  Find Minimum
formula {.} {.} {.} L formuula {.} Find Maxirrium
1 0.6 0.7454 0.26834 1 0.6 0.7454 0.26834
2 0.7| 0.5B857 0.27718 2 0.7| 0.5657 0.27718 Calculate Median
3 0.8 0.4588 0.29363 3 0.8 0.4588 0.29363 Calculate Sum
4 0.9 0.3199 0.25912 4 0.9 0.3199 0.25912 Calculate Product
5 1 0.2538 0.2538 5 1 0.2538 0.2538 Calculate Standard Deviation
6 1.1 0.2149 0.26003 6 1.1 0.2149 0.26003 Calculate Variance
7 1.2 0.1751 0.25214 7 1.2 0.1751 0.25214
8 1.3 0.1479 0.24995 8 1.3 0.1479 0.24995
9 1.4 0.1333 0.26127 9 1.4 0.1333 0.28127
10 1.6 0.1236 0.2781 10 1.5 0.1236 0.2781
11 1.6 0.11 0.2818 11 1.6 0.11 0.2818
12 1.7 0.0973 0.2812 12 1.7 0.0973 0.2812
13 1.8 0.0306 0.28354 13 1.8 0.0306 0.253554
14 1.8 0.0808 0.29169 14 1.9 0.0808 0.29169
15 2 0.075 0.3 15 2 0.075 0.3
16 I _I 16 1
17 17
18 18
19 = 19 -
a1 Sw i ON m
JReturn the mean value of a list
Calculate Mean §|

Input List: L3y | | cakuste|
Frequency List: | [None] - Copy

Mean: | 273441 m
_ teb |

Graph the function over the scatterplot, substituting the average value of L3 for k.
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